Instantly recognize alarms (in red)

Display only waveforms of interest

Check values with the cursor. Calculate the difference between 2 points "on the fly."

Add memos (marks) to key locations for later confirmation

Play back data up to recording start, even during measurement

Zoom in/out on the Y axis. Easily line up overlapping waveforms for confirmation

Customizable layout

Change the split location

Max. 100 devices

100 ms high-speed acquisition

Max. 2000 channels (tags)

The contents of this Technical Information are subject to change without notice.
Contents

Introduction ........................................................................................................................................ii

1. Basic Operation of GA10 ........................................................................................................1-1
   1.1 Collecting Data Easily (Simple Settings) ........................................................................1-1
   1.2 Collecting Data with Detailed Settings ........................................................................1-5

2. Connecting Modbus Devices .................................................................................................2-1

3. Connecting the WT series .......................................................................................................3-1

4. For DAQWORX Users ...........................................................................................................4-1
   4.1 Replacing DAQWORX ..................................................................................................4-1
   4.2 Using DAQWORX with GA10 .................................................................................4-4
   4.3 Comparative Table of DAQWORX and GA10 .......................................................4-5
Introduction

This document describes the setup for GA10 Data Logging Software.

■ Notice

• The contents of this manual are subject to change without notice as a result of continuing improvements to the instrument's performance and functions.
• Every effort has been made to ensure accuracy in the preparation of this manual. Should any errors or omissions come to your attention, however, please inform Yokogawa Electric’s sales office or sales representative.
• Under no circumstances may the contents of this manual, in part or in whole, be transcribed or copied without our permission.
• The images used in this manual may differ from those that actually appear in the software. Such differences do not affect the procedural explanation.

■ Trademarks

• Our product names or brand names mentioned in this manual are the trademarks or registered trademarks of Yokogawa Electric Corporation (hereinafter referred to as YOKOGAWA).
• Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
• Modbus is a registered trademark of AEG Schneider.
• We do not use the TM or ® mark to indicate these trademarks or registered trademarks in this user’s manual.
• All other product names mentioned in this user’s manual are trademarks or registered trademarks of their respective companies.

■ Scope of This Document

This document does not explain the basic operations of the Windows operating system (OS). For this information, read the relevant user’s guide or related materials.
1. Basic Operation of GA10

1.1 Collecting Data Easily (Simple Settings)

Let’s actually connect devices to GA10 and collect data.

* To connect the UT, PR, or JUXTA series; other Modbus devices; or the WT series (excluding the WT3000/WT3000E), see Chapter 2.

Download GA10 from the Web site, and install it in your PC.

To use GA10 as a trial version, you do not need to enter a license key.

Follow the wizard instructions to install the application.
Start GA10.

Start from the Start menu.

Assign a name to the project.

1. On the File menu, click New Project.

2. Enter a name, and click OK.

3. Double-click the new icon.
Simply register devices, and you can start collecting data.

5. Drag the detected GX20 and MW100 to register.

4. Search for devices. (Note)

6. Start data collection and recording.

Monitor: Monitoring only
Record: Saves data to file

Note: If you cannot search, use the Register Device button.

If you want to connect the following devices, see the explanation provided later:
- PR, UPM, or JUXTA series and Modbus devices: Chapter 2
- WT series: Chapter 3

You can start collecting data by simply performing the aforementioned steps.

Data collection starts. Top: Trend monitor Bottom: Digital monitor

A group is created for each device.
If you recorded data, you can view the data with the viewer.

1. Click the icon on the right side to switch to the data list page.

2. Double-click the data that you want to view.

The viewer starts.
### 1.2 Collecting Data with Detailed Settings

Switch to Detail Settings mode.

Use the tabs on the right side to switch pages.

Click the Detail Settings button.

“Detail Settings mode”
Set the items in the left menu in order from the top.

You can change tag numbers and tag comments.

You can enter tag numbers and tag comments.

Select Tag.

You can copy and paste selected lines, turn on and off tags collectively, and assign numbers automatically (increment).
You can assign tags to different groups as you like.
- You can change how to display the waveforms, such as the waveform color, meter type, Y-axis, and scale.

On the View menu, click Display Group.

Group tags any way you like. Automatic assignment by device or by a specific number of tags is possible.

Display group name

Y-axis to use for trends

Meter display type

Max. and min. scale values to display

Zone

Trip: Displays a horizontal guideline.
Example: Specify 5.0.

Zone: Specify the vertical waveform position.
Example: Specify 1 to 25, 25 to 75, and 75 to 100.
Selecting the data time
We recommend you use “PC time,” which does not divide the screen or files.
- Use “Device time” to back up data or when replacing DAQ32Plus.

<table>
<thead>
<tr>
<th>Timestamp</th>
<th>Collection and record interval</th>
<th>Backfill*</th>
<th>Monitor page (Trend/Alarm)</th>
<th>Data file</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC time</td>
<td>Time on the PC</td>
<td>Can be set freely</td>
<td>No</td>
<td>Displayed on a single page</td>
</tr>
<tr>
<td>Device time</td>
<td>Time on the device</td>
<td>Uses the interval on the device</td>
<td>Yes</td>
<td>Page divided by device or collection interval</td>
</tr>
</tbody>
</table>

- Monitoring applications on a PC
- If you want data to be consolidated into a single file
- For replacing DAQLOGGER

* Backfill operates under the following conditions.
- Applicable devices: GX/GP/GM/DX/MV
- Data is retained in the device’s internal memory.
- The device’s FTP function is on.

Changing the monitor screen
- The monitor page can be divided into up to 16 monitor sets.

On the View menu, click Acquisition & Monitor.

Example 1: 4 monitor sets (horizontally divided into 2)

Example 2: 6 monitor sets (horizontally divided into 2)

The available display types are trend, digital, meter, and alarm.

Check the preview.

* Backfill operates under the following conditions.
- Applicable devices: GX/GP/GM/DX/MV
- Data is retained in the device’s internal memory.
- The device’s FTP function is on.
2. Connecting Modbus Devices

To connect a UT, PR, or JUXTA series device or other Modbus device, you need to register a “definition file” containing the device information in GA10.

UT Advanced series devices can be connected without creating definition files.

Create a Modbus device definition file, and save it in a specific location.

You can use the dedicated Modbus Device Definition File Creating Tool to create the file.

1. Enter the device name.
2. Enter the port number and command delay.
3. Set the channel information.
4. Save the settings.
5. Export the Modbus device definition file.

The exported file is saved in a specific folder:

The specific folder:
C:\Program Files\Yokogawa Electric Corporation\SMARTDAC+ Data Logging Software\Modbus
Restart the GA10 service.

On the Start menu, click Control Panel and Administrative Tools, and double-click Services.

Select DLGServer, click Stop and then Start.

The defined device can now be registered on the GA10 Setting Page. The subsequent setting procedure is the same as in the normal case.

The device is added to the list.
3. Connecting the WT series

Download GateWT for GA10, and use it to make the connection.

License: Free
Applicable models: WT210/230/500/1800
  - The WT310/330 can be connected using the WT210/W230 compatible command mode.
  - WT3000/WT3000E can be connected without using GateWT.

Communication port: Ethernet or serial

Select Gate on the GA10 Setting Page.

Connect the WT and run.

Install GateWT for GA10
  - Be sure to read “Readme.txt”
  - Install GateWT for GA10.

Right-click Install.exe, and click Run as administrator.

Follow the wizard instructions to install the application.
Start GateWT for GA10.

1. Select the communication method.

2. Select the device to automatically detect the device type.

3. Double-click the device number to set the channels to load.

4. On the Scan Interval Setting Tab, set the scan interval (msec).

5. On the Execution/Status tab, click the process execution button.

6. Check that the PC information is added to the connection status.

7. Register the device on the GA10 Setting Page.

8. Start data collection and recording on GA10.

When you finish the settings, register the device to GA10.
4. For DAQWORX Users

If you are using the logger software, you can replace it with GA10.  
– Applicable products: DAQLOGGER, DAQ32Plus, MXLOGGER

If the following condition applies, use DAQWORX and GA10 together.  
See 4.2

<table>
<thead>
<tr>
<th>Item</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>Windows XP or earlier is in use.</td>
</tr>
<tr>
<td>Device</td>
<td>A legacy model or a model with an older version not supported by GA10 is in use.</td>
</tr>
<tr>
<td>Communication</td>
<td>GP-IB communication is in use.</td>
</tr>
</tbody>
</table>
| Function      | The following DAQWORX function is in use.  
– Event processor (e-mail transmission, FTP transfer, html conversion, etc.)  
– File utility (file split and merge)  
– Math channels, AO channels, or DO channels are in use. (Mainly, MXLOGGER) |
| Software      | The following software application is in use.  
– AddTrigger  
– AddObserver  
– DataBrowser |

4.1 Replacing DAQWORX

Check the settings of the logger software that you are using, and configure GA10 from scratch.

It is convenient to use the print function to view the settings.
• DAQLOGGER
You can view the settings in the following locations.

- **Display settings** (Scale, Zone, Color, etc.)
  - **DAQLOGGER Manager**
- **Group Editor** (Grouping)
  - **Tag Editor** (Tag No., Tag comments)
- **Software Configurator** (Devices, Communication)
- **Others > Event Processor > Configuration** (E-mail, File conversion, etc.)
- **Others > Report > Configuration** (Report)
- **Logger > Configuration** (Scan intervals, File destinations, etc.)

![DAQLOGGER Manager](image)

Data Monitor

• DAQ32Plus
You can view the settings in the following locations.

- **DARWIN Hardware Configurator** (Math channels)
- **Software Configurator** (Devices, Communication)
- **Tag Editor** (Tag No., Tag comments)
- **Option > Run Auto Processor** (File conversion, Report)
- **Logging > Logging Configuration** (Scan intervals, File destinations, etc.)
- **Logging > General Display Settings** (Scale, Zone, Color, etc.)

![DAQ32Plus Launcher](image)
• **MXLOGGER**
  You can view the settings in the following locations.

  - **General Display Settings** *(Note)*
    - (Groups, Scale, Zone, Color, etc.)

  - **Event Config.** *(E-mail)*

  - **Acquisition** *(Measurement intervals, File destinations, etc.)*

  - **System** *(Devices, Communication)*

  - **Channel** *(Tag No., Tag comments)*

  **Note:** You must start data collection.

• **GA10**
  - Configure from scratch.
  - You can reduce the burden of configuration by using the GA10 tag import feature, tag auto assignment feature, and the Action bar.

  - **Detail Settings > Tag**
    - You can load a list of tag names and tag comments that you created with Excel, Notepad, etc.

  - **Detail Settings > Tag or Display**
    - You can copy and paste selected lines, turn on and off tags collectively, and assign numbers automatically (increment).

  - **Detail Settings > Display > Display Group**
    - You can use automatic assignment by device or by the number of tags.
4.2 Using DAQWORX with GA10

1. Parallel use
   You can use the current configuration and add GA10.

2. Host connection
   By integrating GA10 as a host to DAQWORX, collected data can be consolidated in GA10.

**Use with DAQWORX**

1. Mix GA10 with existing software
2. Connect GA10 as a host

Data can be consolidated in GA10.

1. Parallel use
   Install GA10 in the PC that you are using, and configure from scratch.

No changes

Configure from scratch.
2. Connect GA10 as a host
   - Data that DAQWORX Data Logger is collecting will be consolidated in GA10.
   - Tags that you set in the logger software are automatically reflected in GA10.

1. While data collection is in progress, start the monitor server.

2. On the Register Device page, select DAQLOGGER.

   Device type: DAQLOGGER
   Host name: Enter the PC IP address (or "Localhost").

4.3 Comparative Table of DAQWORX and GA10

<table>
<thead>
<tr>
<th></th>
<th>DAQLOGGER</th>
<th>DAQ32Plus</th>
<th>MXLOGGER</th>
<th>GA10</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic features</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connectable devices</td>
<td>Many devices</td>
<td>Darwin</td>
<td>MX100</td>
<td>Many devices</td>
</tr>
<tr>
<td>Number of device connections</td>
<td>32</td>
<td>1</td>
<td>20</td>
<td>100</td>
</tr>
<tr>
<td>Number of measurement channels</td>
<td>1600ch</td>
<td>300ch</td>
<td>1200ch</td>
<td>2000ch</td>
</tr>
<tr>
<td>Number of math channels</td>
<td>No</td>
<td>60ch</td>
<td>240ch</td>
<td>(TBA)</td>
</tr>
<tr>
<td>Collection (scan) interval</td>
<td>1 s or more</td>
<td>0.5 s or more</td>
<td>10 ms or more</td>
<td>100 ms or more (10 ms or more)*</td>
</tr>
<tr>
<td><strong>Logging</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trigger acquisition</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Yes</td>
</tr>
<tr>
<td>Collection in groups (multilogging)</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Data processing (event processor)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto data conversion</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>e-mail transmission</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>SMTP authentication support</td>
</tr>
<tr>
<td>FTP transfer</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Simple report output</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Monitoring function</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote monitoring (client)</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
</tr>
<tr>
<td>Graphic monitoring</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>No</td>
</tr>
<tr>
<td><strong>Device configuration/control</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device configuration</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Standard software</td>
</tr>
<tr>
<td>IO/AO module control</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Utility</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File merge, split, reconfigure</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td><strong>User privilege</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User privilege</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DDE server</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* When GA10 is used in PC time mode to collect data and the MX100/MW100 collects data at 10 msec
Revision Information

Title: GA10 Data Logging Software Setup Guide
Manual number: TI 04L65B01-02EN

Jan. 2014 1st Edition
Newly published
Feb. 2016 2nd Edition
Periodic correction
Nov. 2016 3rd Edition
Revised for GA10 R3.01

Written by Yokogawa Electric Corporation
Published by Yokogawa Electric Corporation
2-9-32 Nakacho, Musashino-shi, Tokyo 180-8750, JAPAN